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Preparation for Delivery 
This Instructor guide is designed to provide the instructor for the nurse training all the materials required to teach the 
class. 
 

Materials Needed for Class 
• Training Guide 
• 10 to 12 computers with Essentris loaded and tested 
• Class attendance roster 
• Initial Passwords for all users 
• Course evaluation 
• Skills check sheets (one per student) 

 

Tasks to be completed prior to class 
• Verify that all computers are functional 
• Verify that the overhead projector works 
• Verify that the classroom is the appropriate temperature 
• Lay out all handouts one at each terminal 
• Provide each Desk (student) a test patient.  
 

Tasks to be completed at the end of class 
• Ensure that all students signed in 
• Pass out the class evaluation forms, to be filled out before the student leaves.  Make sure there is a comment for 

any score of 3 or below 
• Make sure all skills assessment check lists are completed 
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Duration Essentris Overview Instructor Notes 

 Location of:  
Restrooms: 
Fire Escapes: 
Exits: 
Cell phones pagers: Off or on Vibrate 
Breaks: 

The instructor will fill in this 
section. 

 Introductions  
 Instructor and students exchange relevant information 

 
 

 Subject of the class  
 The class will cover the basic functionality of the Essentris Inpatient 

Records System as it applies to the nursing staff.  Training will focus 
on specific patient care activities that nurses are required to 
document in Essentris. 
 
Duration: 
This class will be divided into four 50 minutes blocks of instruction 
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Duration Description of the Training Instructor Notes 

 This class will not teach all the functionality of Essentris. Additional 
details and functions will be taught in sustainment training as 
needed.  The class will be divided into platform demonstrations 
followed by hands-on practice.  The instructor will demonstrate a 
task and then allow time for any questions.  This will be followed by a 
hands-on practice session with the students performing the task and 
the instructor providing assistance as needed.  At the end of the 
training, a skills assessment check sheet will be completed as well 
as a course evaluation. 

Fetal Monitoring will only be 
covered if the students have 
that capability on their unit. 
 

 Training Goal  
 Provide students with the required information and skills needed to 

complete the documentation of patient care in Essentris. 
 
 

 

 Terminal Learning Objective  
 The student will demonstrate the ability to use the information 

provided in this class to complete the documentation of standard 
nursing procedure in Essentris. 
 
 

 

 Learning Objectives  
 1. Demonstrate the skills necessary to navigate within Essentris. 

2. Describe Security Features. 
3. Understand the five (5) major applications of Essentris. 
4. Effectively document clinical data on Essentris Flowsheets. 
5. Demonstrate an understanding of the Order Entry functions in       
    Essentris. 
6. Demonstrate the ability to document clinical notes on patients in  
    Essentris. 
7. Demonstrate the ability to add and update the problem list. 
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Duration System Description Instructor Notes 
 Essentris is an inpatient medical records system that automates 

inpatient treatment documentation.  It has the capability to connect to 
external monitoring devices such as mother/baby fetal monitoring 
and EKG machines.  Essentris also receives information (ADT, Lab 
data) from external systems such as CHCS.   

 

 System Benefits  
 • Replaces the handwritten chart 

• Allows multiple users to simultaneously access patient 
information 

• Reads data from bedside devices and other systems (Lab, ADT) 
• Calculates IV Drips, I&O, etc. 
• Data is stored electronically for future retrieval 

 

 Areas of Teaching  
 Logging into Essentris 

Keyboard Short Cuts 
The Major Applications of Essentris 
Flowsheets  
• Vital Signs Flowsheets 
• Fluid I&O Flowsheets 
• Medication Flowsheets  
• Lab Entry Flowsheets 
• Treatment Flowsheets 

Administration (ADT and Orders Entry) 
Notes & Interdisciplinary Care Plans 
Review Screens 
Status Boards 
Admitting, Discharging and Transferring a Patient 
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Duration Logging into Essentris Instructor Notes 

 1. Click on the Essentris icon and wait a couple of seconds for 
program to locate the server 

2. Enter your assigned username 
(your three initials/maybe number) press  
the tab-key and enter your password. 

3. Click on change password. Then type  
in your username, old password and  
new password (at least 8 characters). 

Once password setup is complete you will need to log into Essentris 
again. 

Tell the students not to start 
any of the other programs 
while Essentris is loading 
because if you start another 
program Essentris will stop 
trying to locate the server. 
 

 Key Board Short Cuts  
 Navigation Keys: 

[Alt] and [Ctrl] – These keys are used in combination with other 
keys to provide keyboard access to the menu bar and shortcuts. 
[Enter] Key- In many circumstances, the [Enter] key must be 
pressed for data to be entered into a cell or field. 
 
[Tab] Key – In windows containing fields (such as dialog boxes), the 
[Tab] key moves the cursor forward to select the next field.  In 
Flowsheets, the [Tab] key moves the cursor forward to the first row 
of the next section. 
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 Navigation Keys  

  
[Shift] [Tab] – In windows containing fields (such as dialog boxes), 
the [Shift] [Tab] key moves the cursor backwards to select the 
previous field.  In Flowsheets the [Shift] [Tab] moves the cursor 
backwards to the last row of the previous section. 
 
Directional [Arrows] – The Directional Arrow keys move the cursor 
between the rows and columns on the Flowsheets and may also be 
used for menu bar and choice navigation. 
 
[Page Up] Key - The [Page Up] key moves the cursor up one 
display page. 
 
[Page Down] Key - The [Page Down] key moves the cursor down 
one display page. 
[Space Bar] Key – The [Space Bar] key with the [Enter] key deletes 
data from a cell on Flowsheets. 
 
 

 

 Essentris Security  
 Your password in Essentris is the same as your signature.  It should 

not be given to anyone.  If it is compromised the users are required 
to notify the system administrator as soon as they discover that the 
password has been compromised so the password can be 
deactivated. 

 

 Major Applications of Essentris  
 Essentris has five major applications and several sub applications.  

The major applications are: 

• Flowsheets 
• Administration (ADT & Orders) 
• Interdisciplinary Notes & Care Plans  
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Duration Major Applications of Essentris Instructor Notes 
 • Review Screens 

• Status Boards  
 

Note: The care plan area 
can be used for 
interdisciplinary plans of 
care to assist the hospital 
meet JCAHO guidelines. 

 
 Patient Control Screen  
 The main screen of Essentris is the Patient Control Screen.  Based 

on the user’s system configuration this is the first screen that will be  
displayed.  It has the Title Bar, Menu Bar, Patient Header Bar and  
Standard Tool Bar.  Below these are the Application Bar, Unit Bar,  
Application Display and Status Bar. 
Application Bar – Lists all the major applications and sub 
applications.  Everything that is listed in the Application Bar can also 
be accessed via the Menu Bar and by right clicking the mouse. 
Unit Bar – Lists all the units that the user has access to view. 
Application Display – Shows the patients on the selected unit by bed 
number.  The Application Display is auto set for bed number but can 
be sorted by any category i.e. name, fmp-ssn, admit date, attending. 
Status Bar – Located at the bottom of the screen, displays User ID, 
Host Name and IP. Address, Current Time, Status of Joint Context. 
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Duration Title Bar & Menu Bar Instructor Notes 

 The Title Bar displays the title of the currently selected application.  
The Menu Bar is a Windows®-standard format. The menu names 
displayed on the Menu Bar and its drop-down menus will vary 
depending on the system configuration, the unit selected, and the 
application being used.  Menu items on the menu bar are highlighted 
in blue when the mouse hovers over them.  
 
Menu Bar Selections 
File Menu – The File Menu has the following Submenus: Print 
Screen, Join Context, Log Out and Exit. 
Edit – The Edit Menu has the Following Submenus: Cut, Copy Right 
Pane, Copy Right Pane (BMP), and Paste. 
View – The View Menu has the following submenus: One Pane, To 
PatCtrl, To Provider List, Refresh PatCtrl, App Bar and Status Bar.  
ENV – Allows the user the ability to select the environment to work 
in, such as ICU or Training.  By changing environments the user can 
access a note or template that is not available in the currently 
selected environment. 
Admin – This menu provides selections for all the admin functions 
such as Find Patient, Admit Patient, Transfer, Discharge, Lab Stats, 
Tracking board, and other selections based on hospital configuration.
Flowsheets – The menu selection displays the Flowsheet selections 
are based on the users hospital configuration.  Some examples are 
Vitals, I&O, Meds, Treatments. 
Notes – Displays Notes that are available in the current selected 
environment. 
 
 

 
 
 
 
 
 
 
 
 
 
Tell the students the Menu 
Bar selections will change 
based on the area you are in.
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Duration Title Bar & Menu Bar Instructor Notes 
 Orders – Displays the order entry screen. 

Summary Screens – Essentris Summary Screens display 
information categorized into tabular windows and plots for a selected 
patient. 
Waveforms – Waveforms are graphical displays of various 
monitored parameters, such as Pulmonary Artery Pressure (PAP) 
and Arterial Blood Pressure.  Bedside monitors should be used when 
making a medical decision. 
Tools – The tool section describes enhanced printing functions, 
access to CQL, Check Updates, Automatic. 
Web Links – Allows the user to access the local reference library. 
Options – Displays the various options the user has for viewing 
information on the screen.  Some options are: Tree View, List View 
Font, Find Patient View Font. 
Help – The Help Menu has the following submenus: Contents, Help 
Topics, and About Essentris. 
Flowsheets Actions – The items in this menu will vary based on the 
flowsheet being viewed.  Some selections are: Copy Forward, 
Describe Item, Enter Time, Find Row, Refresh Flowsheet and others.
Print Special – The Print Special Menu has the following 
Submenus: Print, Print All Pages, Print Preview and Print Setup.  
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Duration Patient Header Bar Instructor Notes 

 Display Choices 
Patient information is displayed in all application screen headers.  
The display can be configured for each unit to show selected patient 
data. CliniComp Client Services will make configuration changes.  
The default display includes all choices:  
Patient Name  
Patient Age  
Patient Gender  
Unit  
Bed  
Patient Allergies  
MRN  
Billing Number  
Date of Birth  
Admit Date 
Physician  
Military Rank 

 

 Standard Toolbar  
 1. One Pane/Three Pane The One Pane option extends the 

application pane to fill the entire screen. Select the 1 icon to change 
to a single pane view. One Pane/Three Pane can also be selected 
from the View menu.  The Three Pane option restores the multiple-
pane view. Users can toggle between a single workspace or pane, 
and multiple panes at anytime.  This process will be explored further 
later in this class. 
2. Screen Lock  Screen Lock is used to prevent others from altering 
or accessing information when the user is temporarily away from the 
workstation. 
 

Show this function to the 
students in class so they 
understand the difference 
between One Pane and 
Three Pane 
 
 
Tell the students that if they 
leave a workstation they 
should lock the screen. 
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Duration Standard Toolbar Instructor Notes 

 Patients  This is a list of the most recently selected patients. Each 
patient name in the list retains the patient’s environment and the 
application in which the patient was previously viewed. 
4. Recent Views This is a list of the most recently viewed application 
windows. The most recently viewed application is at the top of the 
list.  
5. Previous Screen/ Next Screen These arrows display the 
application screens that the user has recently accessed.  
6. Work Processes  This is a drop-down list of process names. The 
Work Processes are listed alphabetically. Each environment can be 
configured with six Work Processes.  
7. ProcessSteps  For each Work Process, a list of process steps 
such as Flowsheets, Notes, and Growth Charts are contained in the 
ProcessSteps list.  
8. PatCtrl  Use the PatCtrl icon to return to the Patient Control 
screen. PatCtrl can also be selected from the View menu.  
9. ProviderList  A designated provider, such as a doctor, can use 
the Provider List icon to return to the provider patient list from 
another application within Essentris.  
10. Refresh PatCtrl The Refresh PatCtrl updates the display with 
changes entered elsewhere in the facility.  
11. Join Context  Joint Context is a single sign-on user 
authentication system that verifies valid users to all applications in a 
multi-vendor environment.  [Not Used in Most AMEDD Hospitals]  
12. Help Essentris includes online Help that can be accessed by 
using the F1 key, the Help menu in the Menu Bar, or by selecting the 
question mark button on select windows and dialog boxes.   
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Duration Standard Toolbar Instructor Notes 
 13 Shortcut Button  Six shortcut buttons can be configured to link to 

selected applications. (Note that the Progress Notes application 
cannot be linked to a shortcut button.) 
14. Allergy Box 
The Allergy Box is part of the patient header bar.  Note: the allergies 
displayed here are not in AHLTA and the allergies listed in AHLTA 
are not listed here. 
 

 

 Finding a Patient  
 The Find Patient function is used to locate patient’s name, the 

physician’s name or the patient’s medical record number.  
 

 Finding a Patient Practice Exercise  
 1. Select Find Patient from the Admin Menu. 

2. Enter name as “LASTNAME, FIRSTNAME.  The patient 
information must be entered correctly or the patient will not be 
found. 

3. If patient is listed in ‘archive” then proceed with admission into 
CHCS. 

4. If patient being admitted is listed in any unit other than 
“archive” than he/she must be put into “archive” prior to 
admission in CHCS. 

5. Click the OK button. 
 

The instructor must provide 
the students with a patient’s 
name. 
 
Inform the students  
Clicking the Pin Icon in the 
upper right part of the screen 
will put this window on top 
of all other windows. 
 
Note: this PIN functions 
differently on different 
screens. 
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Duration Manual Force Archiving of a Patient’s Chart Instructor Notes 
  If a patient is being admitted and the record is still in the active 

system, it must be archived.  Follow this procedure to manually 
archive a patient’s record. 

1. Left click on patient that you want to archive 
2. Left click on “Tools” button on left tool bar 
3. Left click on “CQL” button within “Tools” tool bar 
4. Enter Essentris username and hit enter 
5. Enter Essentris password and hit enter 
6. Select #32 and hit enter 
7. Enter part or whole patient name at prompt and hit enter 
8. Select patient by number that you want to manually force into 

an archive status. Check the patient name and FMP/SSN to 
ensure the information is correct and then hit enter 

9. Press Y or N based upon appropriate patient and hit enter 
10. Select N at next prompt and hit enter 
11. Select #48 to exit CQL menu and hit enter 

Note: Search for patient again to ensure patient is archived 
 

This information is provided 
in the event you need to 
force a record into the 
archive state. 
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Duration Flowsheets Instructor Notes 

 Basics 
Flowsheets within Essentris can be configured based on hospital and 
unit needs.  Some Flowsheet configurations are restricted by 
charting protocols. 
 
Patient data within a Flowsheet is organized into rows and columns 
in a grid-like format.  Each row contains data items and each column 
represents a time interval. 
Source: Essentris Users Manual Page 71 

 

There is a picture of a 
standard Flowsheet in the 
student guide.  If possible 
show the Flowsheet on the 
screen. 

 When Flowsheet bars are blue and close together the rows are 
collapsed.  This provides more viewing area for the other rows.  To 
expand the rows click in the blue row. 

 

 

 Flowsheet Icons 
 
 
 
Start Row Stop Row Markers:  In standard rows, Start Row and 
Stop Row markers are use to draw attention to a series of columns. 
 
 
 
 
Read Monitor: Imports data from a connected, pre-configured 
device such as a physiological monitor or ventilator into an Essentris 
Flowsheet.  This is used to read the monitor one time after the button 
is pressed. 
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Duration Flowsheets Icons Instructor Notes 
  

 
 
 
Auto Read Monitor: Imports data from a connected, pre-configured 
device such as a physiological monitor or ventilator into an Essentris 
Flowsheet.  Auto Read Monitor stays on until turned off or a pre-
configured amount of time has passed. 
 
 
 
 
Annotation:  This feature is used to add an annotation to a data cell.  
An annotation is used to provide more detailed information of an 
issue or event that is discrete to a specific time.  An annotation 
should always be added if a medication is held.  
 
 
 
 
View History:  This feature is used to view changes that have been 
made in the data cell. 
 
 
 
 
Describe Item:  This feature is used to view information such as: full 
name, display name, data value, the user’s name that stored the 
information and unit (if stored in the cell). 
 
 
 

 

Essentris Instructor Guide       Nurse 
16 



Essentris Instructor Guide       Nurse 
 

 

Duration Flowsheets Icons Instructor Notes 
  

 
 
 
 
Enter Time Icon (Clock):  This feature is used to add a new column 
between configured columns on a Flowsheet or reposition the 
Flowsheet to a specific time. 
 
 
 
 
 
Refresh Icon:  This is used to refresh the screen.  If other staff 
members are working on the same patient their saved data will 
appear on your screen when you refresh.  *Caution, if a screen is 
refreshed before data is saved any unsaved data will be lost. 

 
Store (Save) Icon:  This feature is used to save or store your data.  
If the icon is grayed out as shown here there is no data available to 
save. 
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Duration Flowsheets Navigation Instructor Notes 
  

 
 
 
 
The Navigation Icons are located on the right side of the Flowsheet 
Navigation Menu.  The key icons are NOW, PREV and NEXT.  The 
icons are in addition to horizontal scrolling. 
NOW Icon 
Click the Now icon to position the Flowsheet in the most recent time 
column. 
PREV Icon 
Use the PREV icon to move the Flowsheet display one page of data 
back in time.  The PREV icon is grayed out when there are no 
previous pages. 
NEXT Icon 
Use the NEXT icon to move the Flowsheet one page forward in time.  
The NEXT icon is grayed out when there are no later pages. 
Scroll Bar 
The Scroll Bar can function similarly to the PREV and NEXT icons.  
Click on the right end of the scroll bar to move the display forward in 
time one page, or click on the left end of the scroll bar to move the 
display backwards in time one page.  Click and hold down the mouse 
key on the left or right end arrow to scroll continuously through the 
Flowsheet. 
Scroll with the Mouse The mouse wheel can be used to scroll up 
and down within any flowsheet. 
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Duration Vital Signs Flowsheets Instructor Notes 
 1. Click on Flowsheets, select Vitals 

2. Click on a data cell to enter data 
      i.e. Temp, HR, NBPs/d. type in the desired number 
3. Store the data by pressing the Enter Key, by 
      moving down one cell with the arrow keys, or by clicking 
      the Store Icon   
 

Note: Clicking (Ctrl+s) will also bring up the store screen as well.   
 

 

 

 Entering Time in a Flowsheet  
 Use the Enter Time feature to add a new column between 

configured columns on a flowsheet, or to reposition the flowsheet at 
a specific date/time column. 

 

 

 Entering Time in a Flowsheet Practice Exercise  
  

1. Select Enter Time from the Flowsheet Actions on the Menu Bar  
 or Click the Enter Time Icon 

2. Click on the date or time on the Enter Time dialogue box. 
3. Modify the value using the small arrows 
4. Click the large down arrow to select a date from a drop-down  
     calendar 
5. Click Ok 

 

The instructor should 
demonstrate this to the 
students before they 
complete the exercise.   
 
The instructor should tell the 
students what to enter. 
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Duration Vital Signs Flowsheets  Instructor Notes 

 Erasing Data 
To erase data before it is stored and the cell is still selected press 
the Space Bar, otherwise select the Cell then press the Space Bar. 
 
Modifying Data 

1. Click on the cell to be modify 
2. Modify the data  
3. Select the Store icon. 

 
Making Annotations 

1. Place the cursor in a cell and right click.   
2. Select annotation or the annotation Icon.           A box will open.  
3. Type the note.  
4. Once the Note is completed, click OK or press the Enter key.  
This will place an asterisk in the cell.   
 
To read an annotation right click and select annotation. 
To see who wrote the annotation right click, then select view edit 
history. 

 
 

 

The instructor should 
demonstrate Erasing Data, 
Modifying Data and Making 
Annotations in class. 
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Duration Using Event Markers Instructor Notes 

 Events are charted in the Plot section of the Vitals Flowsheet.  
They are useful for displaying additional information about time-
sensitive events or monitoring changes  
in data trends.   
 
To add an event marker: 
1.  Place cursor in the appropriate time column of the Plot section; 

the field will become highlighted and a drop-down list will appear.  
2.  Select an event from the pick list or free type an event into the    
      column. 
3.  Press the Enter key.   
The event will display vertically in the column. Only one event can 
be entered in a single column.   
 
To document multiple events for a given time, it is necessary to add 
additional  time columns, spaced 1 minute apart for each event.  
Use the       icon to insert new time  
columns. 
 
To use the Add Row feature add an optional row or group of rows to 
standard Flowsheets i.e. Circulation Check, PCA etc.  
1. Select a date and time column for Start Row marker.  
2. Click on the Flowsheets Actions menu bar and select Add Row 

 option or Right click on an existing row and select Add Row from 
Shortcut Menu.  

 
To add a single row from Add Row Dialog box click on row name in 
Optional Items window and click the Add button. To add a group of 
rows click on group name in Add Group window and click  
Add button. 
 

 

Essentris Instructor Guide       Nurse 
21 



Essentris Instructor Guide       Nurse 
 

 

Duration Vital Signs Flowsheets Practice Exercise Instructor Notes 
 Select the test patient that was provided at the start of the class and 

enter the following information in the appropriate box. 
 
Note:  If your computer has timed out, login again 
 
Enter the following information in the appropriate box. 
 
Temp 99.7 
BP 130/70 
Resp 18 
Make an annotation that the patient “appeared anxious” 
Change the Temp to 100.1 
Store the information 
 

 

 

 Fluid Balance (I&O) Flowsheet  
 Source: Essentris Users Manual 

Use the Fluid Balance (or Intake and Output) flowsheet to chart 
intake and output values.  Intake and output totals are automatically 
calculated to show fluid balance for patients.  The Fluid Balance 
(I&O) Flowsheet contains the following specialized features:   
 

• Summary Box 
• Daily Summary section 
• Totals Section 
• Weight Section 
• Intake and Outputs Section 

The intake and output sections of the flowsheet can be configured 
with subsections to further organize fluids.   
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Duration Fluid Balance (I&O) Flowsheet Instructor Notes 
 Intake and output fluids are sorted into categories within the sections 

of the flowsheet.  The categories that are commonly used are: 
Output, IV, Drug, TPN, Meds, Oral, NG, Crystalloid, Colloid, Blood, 
Urine, Chest Tube Output, Blood Outputs, and Irrigations.  As fluids 
are assigned, they are sorted and placed in the flowsheet using the 
criteria in the order specified below. 

1. By Fluid – Intake or Output 
2. By Fluid Category 
3. By Fluid Name in alphabetical order 
4. By Order of Time Assigned 

 

 

 Intake Flowsheet row typically display the following information: 
• Name 
• Site 
• Label Comment 
• Rate at Date / Time of Active Cell 
• Volume (in ml) 

 

 

 Fluid Balance (I&O) Flowsheet Practice Exercise  
 To Add IV site:  

1. Select the I&O Flowsheet. 
2. Click on desired data cell.  
3. Right click, select change site.  
4. Select appropriate IV site.  
5. Click OK. The IV site will appear on the left screen in the  

  same box as IV solution.  
6. To Change IV Rate place cursor in time block desired and  

press the (Shift-key+@). 
 simultaneously) and then enter the new flow rate.  

      7.  Press enter and new rate will appear on screen 
 next to IV solution.  

      8.  To save your data click on the storage disc. 
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Duration Fluid Balance (I&O) Flowsheet Practice Exercise Instructor Notes 
 To Annotate Hanging a New Bag of the IV Fluid  

1. Click on the desired cell that you want to document hanging a 
new bag. 

2. Press the (Shift-key+^ simultaneously). 
3. Enter amount of fluid (500 or 1000). 
4. Press the Enter Key. 
5. Click on the Store icon to save your data. 

 

 Special Keys: 
• @ = Rate [Shift 2], type rate value, and press [Enter] 
• ~ = Site [Shift ~] and press [Enter] 
• ^ = Hang a new bag [Shift 6], type volume value, and press [Enter] 
• Insert Key = Enters the amount of IV fluid delivered since the last 
entry of IV fluid.  Daily weights are documented at the bottom of the 
Flowsheets.  

 

 

 Medication Flowsheet (Medication Administration Record)  
 Use the Medications Flowsheet to chart medication orders. Orders 

can be delivered, discontinued, held, or rescheduled on the 
Medications Flowsheet. Remarks can also be created to note 
important information about a medication order. 
The Medications Flowsheet is divided into sections that are 
configurable to the requirements of each hospital. Sections of 
medication orders can be configured in the following two ways: 
1. According to medication schedule  
    For example: PRN, Scheduled, STAT 
2. According to medication type  
    For example: Antibiotics, IV Fluids, Pain Medications  
Flowsheet Box colors 

Green Box – Medication is due, but not past due 
Red Box – Medication is past due 
 

 
 
 
 
 
 
 
 
 
 
 
 

There is a picture showing 
the Green and Red boxes in 
the student guide 
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Duration Medication Flowsheet (Medication Administration Record) Instructor Notes 
 Medication rows can display the following information:  

Name of medication 
Route 
Dosage 
Frequency 
Schedule Markers 
Order Comment - This comment originates in the Order Editor and is 
a permanent part of the order. It cannot be altered.  
Remarks - Use Medication Remarks to display information that is 
pertinent to a medication. A Remark can be edited or deleted (unlike 
an Order Comment that cannot be edited or deleted). 

 

 

 Delivery Comment  
 Delivery Comment - A comment can be placed in the data cell for 

the delivered medication. Select the data cell and enter the 
comment. Comments must begin with an alpha character. The 
comment appears on the second line of the data cell, under the dose 
line.  
Source Essentris Users Manual 
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Duration Medication Flowsheet (Medication Administration Record) Instructor Notes 

 Giving a Medication 
1. Select a data cell for medication delivery 
2. Select Give Med from the Flowsheet Action drop-down menu 

on the Menu Bar or select the Give Med icon.  
 

Tell The students the 
following: 

a. You can also right click 
on the data cell and 
select Give Med from 
the shortcut menu. 

b. A delivery marker is 
displayed in the 
selected data cell and 
is displayed as either a 
check mark or a dose 
delivered. 

c. The dose ordered can 
be keyed-in.  The 
check mark appears 
when the keyed-in 
dose matches the 
ordered dose, including 
character spacing and 
case. 

The check mark function is 
configurable. 
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Duration Medication Flowsheet (Medication Administration Record) Instructor Notes 

 Hold Medication Delivery    
Use the following steps to hold medication 
 

1. Select the data cell in a time column for the medication held. 
2. Select Hold Med from the Flowsheet action dropdown menu 

or select the Hold Medication icon.      
 

 

a. The user can right 
click on the data cell 
and select Hold Med 
from the shortcut 
menu. 

b. Hold orders will 
display “Held” in the 
medications 
Flowsheet time 
column. 

c. If a medication is held, 
an annotation must be 
entered. 

 

 Discontinue a Medication  
 A medication row that is discontinued drops off of the flowsheet 

screen after a specified time period. A medication row that is 
discontinued is discontinued on every flowsheet the medication 
appears on. For sites with a pharmacy interface, external orders can 
be discontinued from a flowsheet. This option is configured by 
CliniComp Client Services 
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Duration Treatment Flowsheets Instructor Notes 

 Treatment Flowsheet are used to document such procedures as  
General Education, Hygiene and Teaching of Safety procedures. 

 

 Treatment Flowsheets Practice Exercise  
 To access the Treatment Flowsheets 

1. Click on Flowsheets, select Treatments.   
2. The highlighted boxes indicate when a treatment is due.  
3. Put an X, (completed) or noted in the data cell. You can select  
all the boxes one at a time and store  them together by using the 
store disk icon.  
4. Once you have completed this, click the Store Icon. 

Your username will appear in the data cell.   

 

 Modifying a treatment schedule time  
 To modify a treatment schedule time:  

1. Click in the desired cell 
2. Right click and select the action. Available options are Set 

Frequency, Reset 
3. Schedule, Set Schedule and Delay Schedule.   
4. Insert a new time column using the  icon when needed to 

document that a treatment was given.   
 

 

 Making an Annotation   
 To Make an Annotation  

1. Place cursor in cell 
2. Right click select annotation or select the Annotation icon 
3. Type your annotation 
4. Click OK or press the Enter key 
This will place an asterisk in the cell.   
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Duration Adding a Row to a Treatment Flowsheet Instructor Notes 

 Rows can be added to a Treatment Flowsheet.  Treatments that the 
user is required to completed may not be on the default Flowsheet.  
Those treatments can be added to the Flowsheet. 

 

 

 To add a row to a treatment Flowsheet do: 
 

1. In the Treatment Flowsheet select an empty cell and right 
click the mouse. 

2. A pop-up selection box will appear, Select Add Row from the 
selection list 
 
 
 
 

 
 

 

 Another pop-up selection box will appear.  You can select a 
group of treatments or an individual treatment. 
 
 
 
 
 
 
 
 
 
3. Select an individual treatment. 
4. Click the Add button. 
The treatment is added to the treatment Flowsheet. 
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Duration Laboratory Flowsheets Instructor Notes 

 Use the Laboratory Entry Flowsheet to chart the results of lab tests. 
Data can be entered directly in the Laboratory Entry Flowsheet, or 
information can be sent through an interface to a laboratory 
computer system. The Laboratory Entry Flowsheet contains the 
following specialized features: 
High/Low Flags 
Toggle Tooltip 
 
High/Low Flags 
High and low flags can be configured to indicate when lab results 
have values outside a specified normal range.  A value that is higher 
than the normal range is indicated with an H and a value that is lower 
than the normal range is indicated with an L.  These flags are only 
displayed for data received through an interface.  
 
Toggle Tooltip 
The Toggle Tooltip feature displays a high/low flag, if any, followed 
by the normal range for the lab test.  
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Duration Orders Entry Module Instructor Notes 

 Essentris Order Entry is a permissions-driven application for placing 
orders, communicating orders, tracking orders, and maintaining an 
audit trail of orders.  Currently Lab, Pharmacy and Radiology orders 
that are entered into Essentris are not sent to CHCS for actual order 
completion and resulting.  This means that some orders must be 
entered into CHCS.  Those types of orders are Laboratory, 
Pharmacy and Radiology orders.  Once the Laboratory, Pharmacy 
and Radiology orders are entered in CHCS and completed, the 
results are sent back to Essentris. 

Make sure the students 
understand the following: 
 
Order Entry is completed 
by the physician.  It is 
taught here because there 
may be a rare occasion 
that requires entry of 
verbal orders.  

 
 Medication orders are entered into Essentris.  The pharmacy 

process can be accomplished in one of two ways.  Either the 
Pharmacy can receive the order on its Essentris printer and then 
transcribe the order into CHCS, or the pharmacy can receive the 
orders electronically onto a Pharmacy Status Board.   Either way, 
the pharmacy staff must still enter the order into CHCS. 

 

 Some hospitals have the ability to send information to other external 
systems.  For instance, WRAMC sends dietary orders to their diet 
system.  Check with your local instructor for any specific interfaces 
at your facility.   
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Duration Standard Order Sets Instructor Notes 

 Within Essentris, order sets can be established to promote speed of 
entry and to support clinical pathways/best practices/practice 
guidelines.  A Standard Order Set is a named collection of orders. 
Standard Order Sets are used to enter a group of orders which are 
commonly used together as part of a standard treatment regimen.  
Standard Order Sets are typically used either as an all-inclusive 
group of orders with the entire group assigned to the patient, or 
cafeteria style where individual items are assigned a la carte.   
Order Sets are primarily done by the physicians, but can also be 
used by other services such as Nursing for an order set of Nursing 
Initiated Orders for admission protocols.  This training will 
cover how to pick an order set but you will need to work with your 
local administrator to build specific order sets.   

Note: Resource Essentris 
Users Manual 

 Accessing Order Entry  
 Order Entry can be accessed from the Application Bar  

or the Menu Bar. To access Order Entry, a patient  
must be selected and the active unit must be an  
Order Entry unit.  On the Application Bar the Order Entry  
button is located in the Orders pane. 

 

 Some Order Entry actions can be invoked directly from a 
Flowsheet, such as placing a New Order and DCing an  
existing order (available Flowsheet capabilities depend on  
Flowsheet configuration). 

 

 Nurses will enter nursing initiated orders (NIO’s) and  
Acknowledge/verify physicians orders and enter minimal verbal  
orders based upon local policy. 
This section will guide the student through entering a medication 
order. 
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Duration Order Entry Practice Exercise Instructor Notes 
 1. Select the Order Entry button on the Application Bar. 

2. Select the New icon. 
3. Select the category of the Order, which for this exercise will be 

medication  (you can also type the first letter of the category). 
4. Click OK. 

Orders can have subcategories as well.  The Sub Categories will 
appear once the Category has been selected.  
 
Once the category is selected the Order Editor appears. 
  5.  Select the Order time from the drop down. 
  6.  Select the Start time from the Start Time drop down list. 
  7.  Select the Stop time from the Stop Time drop down list. 
  8.  Select a medication from the medication drop down list (Name 

field).  
  9.  Select the Dose field and enter the dose. 
10.  Select the Route field and enter the Route. 
11.  Select the Priority field and enter the Priority. 
12.  Select the provider from the Provider drop down list. 
13.  If it is a Verbal Order, Check the Verbal/Telephone Read-Back 

Box. 
14.  Click the Check icon to store the order. 
 

Make sure the students 
understand the following: 
 
Order Entry is completed 
by the physician.  It is 
taught here because there 
may be a rare occasion 
that requires entry of 
verbal orders.  
 
 
Order Editor has numerous 
drop down selection lists.  
Some of these lists are 
templates which the local 
hospital develops.  One 
example is the pharmacy 
choice list.  It is based upon 
the local hospitals formulary. 
 
Note – This is based upon 
local formulary as noted 
above.  Your instructor will 
tell you what to select. 
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Duration Acknowledge an Order Instructor Notes 

 Acknowledge an Order is typically associated with the RN.  After the 
physician completes the medication order and signs it the order goes 
into a pending status.  The ACK Column is blank indicating that the 
order has not been acknowledged, as shown below: 

 
 
 
 

 

 The nurse completes the following steps to acknowledge the order: 
1. Select the row with the order that needs to be acknowledged. 
2. Right click on the selected row and select Acknowledge. 
Three asterisks appear in the ACK column of the selected row, as 
shown below:  
 
 

 
 

 

 Store the order 
3. Once the order is acknowledged, the initials of the nurse storing 

the order are displayed in the ACK column as shown below. 
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Duration Clinical Notes Instructor Notes 

 The Notes Application allows the user to create, edit and navigate 
clinical notes as well as the ability to add and edit a care plan. 
 
Notes can be configured based on hospital or individual inpatient unit 
requirements.  There are many different types of Notes within 
Essentris.  Some of these include MD Progress Note, Nursing 
Assessment Note, Occupational Therapy Note, Discharge, etc.  

 

a. The configuration of 
Essentris Notes will be 
based on the latest 
AMEDD guidelines.  No 
new data elements will be 
added to the Essentris 
data base without 
approval of the AMEDD. 

b. Show the students how to 
pull Notes from other 
Environments. 

 
 Accessing Clinical Note Practice Exercise   
 1. Select the Notes from the Application menu on the left side of the 

screen or from the menu bar.  
2. Select the New Note Menu icon. 
 
The Notes Selection Box will appear. 
3. Select the appropriate Note (Admission Nursing Assessment or 
Progress Note). 
4. Click OK. 
If the Clinical Note requires a Topic, the Notes Topics Window will 
appear.  (This Note does not require a topic so you will not see this 
screen for the training exercise.) 
 
5. Select the Source of Entry Drop Down list and select_________ 
6. Select Subject of Note Drop Down list and select____________ 
7. Select the Text of Note, Enter __________________________ 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

The instructor will need to 
provide the drop down lists 
selections. 
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Duration Edit a Note Instructor Notes 
 From the Notes Action menu, select the Edit Note option. 

A validation Dialog box will appear. 
Enter your user name and password. 
The note opens in the edit mode.  The editable fields in the note are 
identified by thick borders.   
Once you have edited the note use the Close Note menu selection to 
close the note. 
Select Close Note from the Notes Menu.  You can also click the X in 
the upper right corner to prompt for a username/password box. 
 
A validation Dialog box will appear. 
Enter your Name and password. 
Click OK. 
 

 

 Copy Forward an Existing Note  
 Essentris has the ability to copy a patients’ note forward.  If a 

patients’ condition is unchanged or has shown minor changes, the 
Note from the last shift can be copied forward and changes made an 
stored as a new note. 
 
Extreme caution must be used when using this functionality.  The 
Note that is copied forward must have an update on the patient’s 
current condition after the note is copied forward.   
 
To copy a note forward: 

1. From the Notes menu select the Note you want to copy 
forward. 

2. Right click on the selected Note and select “Copy Forward” 
3. Enter the required information 
4. Store the Note. 
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Duration Interdisciplinary Care Plans Instructor Notes 
 Care Plans are preconfigured guidelines, which can be tailored to the 

needs of a particular patient.  When the Care Plan function is 
entered, the Active Problems window is the default display.  Toggle 
to view All Problems by selecting the All/Active Problems option in 
the Care Plan menu. Use the Care Plan menu to assign and update 
Care Plan problems. 

The care plan area can be 
used for interdisciplinary 
plans of care to assist the 
hospital meet JCAHO 
guidelines. 

 
 Interdisciplinary Care Plans Practice Exercise  
 1. Select the New Problem / Assign Problem Icon. 

2. Select a problem from the Topic list. 
3. Enter a Date and Time, click OK. 
4. Enter the Note and select Store Changes. 

A validation Dialog box will appear. 
5.  Enter your Name and password. 
6.  Click OK. 
7.  Select Close Note from the Care Plan Note Menu. 
 

 

 

 Status Boards  
 Source CliniComp Essentris Users Manual Ver. 1.4.2 

The Status Board application retrieves patient information and 
displays it in a summary chart.  Columns can be configured to 
display various types of patient information.  The columns can be 
configured to sort the various displays.  The status board can 
determine the physical location and status of a patient from any 
physical location and any Essentris PC within the health care facility.  
Patient information is dynamically updated.  Some columns can be 
edited, however most are not. 
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Duration Summary Screens Instructor Notes 

 The Essentris Summary Screens display information categorized into 
tabular windows and plots for a selected patient. Each summary 
screen covers a specialized clinical aspect of patient care. The user 
is provided with a choice list of screens to select for viewing. 
To access the Summary Screens, perform the following steps: 
1. Select the patient to view. 
Select the Summary Screen tab from the Application Bar and click 
on Summary Screen. 

 

 Admitting a Patient  
 Admitting a patient is a Patient Administration Division (PAD) 

function.  It is taught in this class so you will understand how it is 
done.  If this is not done correctly Laboratory, Radiology, or 
Pharmacy functions cannot be documented correctly for the patient.  
Also, the likelihood of duplicate charts that cannot be merged is 
increased if the person who manually admits the patient enters 
incorrect or misspelled information.   

 

 Admitting a Patient Practice Exercise  
 New patients can be admitted to Essentris by using the Admit option. 

To admit a patient, follow the steps below,  
 
1. Select the Admit Tab in the Applications Menu 
2. Enter the required information in the Bed/Unit Fields 
3. Enter the required information in the Enter Admission Data 
4. Enter the required information in the Enter Admission Data fields 
5. Click on the OK button to complete the Admission. 
      Validation Dialog pop-up will appear 
6. Enter your user name and password 
7. Click OK 
     The PatCtrl pop-up will appear 
8. Click OK 
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Duration Discharging a Patient Practice Exercise Instructor Notes 
 To discharge a patient complete the following steps: 

1. Select the patient to be discharged. 
2. Select [Discharg] from the Admin menu. 

  A pop-up will appear asking for your name and password. 
3.  Enter your name and password. 
4.  Click OK. 
A Dialog box will appear asking if you want to Discontinue All Active 
Orders. 
5.  Click Yes, to complete the discharge. 
 

Note: You can also do this by 
dragging and dropping the 
person into the Discharge 
environment 

 Transferring a Patient  
 In Essentris, it is possible to transfer patients from one bed to 

another within the same unit or between units.  
 

 

 Transferring a Patient Practice Exercise  
 1. In the Application Display select the Patient you want to transfer. 

2.  Select Transfer from any of the Admin menus and perform the     
     following steps: 
Enter the required information in the Transfer window. 
4. Once the appropriate information is entered click the Transfer  
     Arrow. 
The password Dialog Box will appear. 
5.  Enter your user name and password. 
6.  Click Yes to Discontinue Active Orders 

a. You cannot transfer a 
patient into an occupied 
bed or to a unit that is  

b. inaccessible. 
c. It is usually a good idea 

to make sure there is a 
bed available where the 
patient is to be 
transfered. 

d. This can be 
accomplished by simply 
dragging and dropping 
the selected patient onto 
the PatCtrl screen 
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Duration Menu Selections Instructor Notes 

 Help Menu  
 On each screen in the middle right of the screen there is a help 

button that contains an online manual.  Help topics can be accessed 
by clicking the index tab located on the upper left side or by typing in 
a question. 

 

 

 Tools  
 The tools menus has the following selections: Enhanced print 

options, Access to CQL, Check Updated, an automatic update 
feature and change password. 

 

 

 Change Environment  
 To change the environment: 

1. Right click on the patient’s name and select ENV.  
2. Slide the mouse to the right.    
3. Pick the desired environment for viewing notes. 

 

 

 Flowsheets and Orders Your Environment  
 This can be used if the patient was admitted to the Emergency 

Department and transferred to one of the units. If the ED did not 
finish a note and they look the patient up after the patient has been 
transferred they will get the previous unit’s notes. To see the ED 
notes they would have to change their environment. 
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